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Abstract
This is a laboratory activity for monochord1 . It investigates basic aspects of plucked-string
vibration in the time and frequency domains. Students will preferably have taken physics in
high school and may even be familiar with some topics from college-level freshman physics.
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Introduction

This lab should help you better understand the mechanics of sound waves generated by a vibrating
string. First we will look at plots of the vibration versus time. Next, we will look at the effects
of plucking the string harder. We will apply theory about exponential decays to estimate the
decay time constant of the vibrating string recording. Next, we will consider the pitch of the
sound and attempt to determine the string’s fundamental frequency. Finally, we will observe
signal components with frequencies other than the fundamental frequency (so-called “harmonics”
or “overtones”). The profile of signal energy at various frequencies is known as the spectrum, and
we will see how the vibration spectrum can be manipulated by changing various parameters of the
string and its plucking excitation.
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Summary of Objectives
• Measure and display plucked-string vibration as transverse velocity versus time.
• Study the amplitude envelope, or “shape”, of the plucked string waveform over time.
• Understand exponential decay and apply the concept to vibrating string recordings.
• Measure the physical effects of plucking harder and compare to theory.
• Measure the fundamental period of the plucked-string vibration.
• Determine the fundamental frequency of the plucked-string vibration.
• Investigate parameters which affect the spectrum (frequency content) of the plucked-string
vibration.
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Background

Students should have taken the equivalent of a high school physics class before attempting this laboratory exercise. Knowledge of college-level freshman physics would be helpful but is not required.
The lightly-damped oscillator is a fundamental concept from freshman physics. It consists of a
spring with constant k, a mass m, and a damper with a small damping coefficient R (see Figure 1,
left). It is a very simplified model of a plucked vibrating string (see Figure 1, right). Any string
has a rest position. If it is pulled away from its rest position (i.e. plucked), then it will vibrate
until friction and other losses cause it to cease its motion. Other analogies may be drawn as well.
When the lightly-damped oscillator is given an initial condition, such as if the 1kg mass is pulled
away from its resting position to x(0) = 2m and released, the mass will vibrate back and forth (see
Figure 2, top). It is assumed that the force of gravity is negligible in comparison with the force
q due

1
k
to the spring. The spring constant k = (2π)2 , and so the frequency of vibration is f ≈ 2π
m =1
Hz. The energy of the system is stored alternately in the potential energy of the displaced spring
EP E (t) = kx(t)2 /2 and the kinetic energy of the moving mass EKE (t) = mv(t)2 /2. Recall that
v(t) = dx(t)/dt is the velocity of the mass. The total energy E(t) is the sum of the potential and
kinetic energies.
(1)
E(t) = EP E (t) + EKE (t)
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Figure 1: Lightly-damped oscillator (left), vibrating string (right)

Figure 2 (middle) shows the behavior of the energies. The damper causes the energy stored in
the system to dissipate over time, and so eventually the mass will come to rest again. In fact, the
faster the mass moves, the more quickly energy is removed from the system. This means that for
small amounts of damping, the function of the energy in the system E(t) decays exponentially over
time. τ is defined to be the time constant for the exponential decay.
E(t) = E(0)e−t/τ

(2)

It is a little bit hard to tell what τ is from a plot of E(t), so often times 10 log10 E(t) is plotted
instead because it is a line (see Figure 2, middle).
10 log10 E(t) = 10 log10 (E(0)e−t/τ ) = 10
10 log10 E(t) = 10

loge (E(0)e−t/τ )
loge 10

loge e−t/τ
log E(0)
−10t/τ
log E(0)
+ 10 e
=
+ 10 e
loge 10
loge 10
loge 10
loge 10

(3)

(4)

We see that τ is inversely proportional to the negative of the slope s of 10 log10 E(t). Judging
by the red portion of the line in Figure 2 (bottom), we estimate that s = −1−14
9−2 = −2.15dB/sec.
−10t/τ
= st
loge 10

(5)

−10
s loge 10

(6)

τ=

We find that τ = 2sec. This is the amount of time it takes for E(t) to decay to e−τ /τ = e−1 ≈ 0.37
of its initial value E(0) (see Figure 2 (middle)). Just above, in Figure 2 (top), the time constant
for the exponential decay of the displacement x(t) can be seen to be about 4s. It is in fact exactly
4s. Consider where the extra factor of 2 may come from. (Hint: This has to do with the fact that
sometimes 20 log10 is used instead of 10 log10 to convert exponential decays to linear decays.)
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Figure 2: Displacement of a lightly-damped oscillator (top), energy stored in the oscillator
(middle), and log-total energy stored in the oscillator (bottom).
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Theory Of Vibrating Strings

To obtain insight into the more precise behavior of a plucked vibrating string, it is helpful to
consider the traveling wave-based theory of plucked string vibrations. Imagine an infinitely long
stretched string that is plucked simultaneously at three points to create an initial triangular displacement, as shown by the thick black line in the initial state of the plucked string animation.
Press the “play” button of the Flash animation, and watch what happens when the “three picks”
are released. The thick black line shows what happens to the ideal string. The corners at first
flatten, and then two half-amplitude triangular pulses emerge, traveling in opposite directions.
These are traveling waves. In fact, the initial shape of the string is best considered as the sum
of those two half-amplitude pulses. When one of these traveling waves encounters the end of
the string, it reflects back in the other direction. For more information, see the traveling waves
laboratory assignment.2 For a mathematical derivation of this classical traveling-wave model for
ideal plucked-string behavior, see the page entitled “Elementary String Instruments” in the online
textbook Physical Audio Signal Processing.
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Equipment

Your instructor should have assembled and calibrated a lab environment in accordance with the
monochord assembly instructions3 [1] and the soundcard set-up instructions4 instructions [2]. In
general, the lab requires the following equipment:
• monochord assembly, as described in the monochord assembly instructions.
• a calibrated PC sound system, as described in the soundcard set-up instructions.
• a computer running Pure-Data Extended (pdx),5 and
• a guitar slide or similar object.
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Procedure

6.1

Part 1: Setup

In order to understand the rest of the lab, it is important to first understand the signal that
is generated by the monochord assembly and interpreted in Pure Data (pd).6 The monochord
consists of a tightly stretched string which passes between two magnets. As the string vibrates,
the magnets produce an electrical signal along the string. Physically, the signal corresponds to the
velocity at which the string passes between the magnets. Thus, if the string vibrates more quickly,
the electrical signal will oscillate more quickly. Similarly, if the string is plucked so as to generate
a louder sound, the electrical signal will be stronger. (If the optical pickup is used instead of the
electromagnetic pickup, then the measured signal corresponds to the string displacement instead
2

http://ccrma.stanford.edu/realsimple/travelingwaves/
http://ccrma.stanford.edu/realsimple/mono inst/
4
http://ccrma.stanford.edu/realsimple/soundcard test/
5
http://puredata.info/
6
http://crca.ucsd.edu/˜msp/software.html
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of the velocity and similar statements may be made.) This electrical pickup signal is amplified by
the sound card input and read into the computer as a sound wave. Roughly speaking, the electrical
signal that is visible on the computer corresponds to sound wave received by your ear.
1. Begin by opening pd if the software is not already open. In Windows, this will likely involve
clicking the Start button and selecting Start → Programs → Pure Data → Pure Data.
2. Download the lab patch 1-1 (1-1.pd)7 and save it to a local directory. Then open 1-1.pd
with pd. One way to do this is to select Open from the File menu.
Check to make sure that the patch is not in “edit mode” by clicking on the Edit menu in the
lab patch. If there is a check mark for edit mode (at the bottom of the edit menu), click Edit
→ Edit Mode in order to clear the check mark.
3. Patch 1-1 contains three displays, but depending on the resolution of your monitor, you may
need to scroll down to see the third display. The top two displays allow the user to record a
10 second sound clip. The bottom display represents a 200 ms sample that is automatically
updated to reflect the signal currently being received by the sound card.
Enable the sound input by checking the “compute audio” box in the upper right corner of
the main pd window, or by selecting Media → audio ON in the main pd window. Sound can
also be toggled easily on Windows or Linux by pressing Ctrl-/ to turn sound processing on
and Ctrl-. to turn sound off. Click the “Begin Display” button to enable the patch. At this
point, pluck the string to confirm that pd is receiving an audio input. This will be confirmed
by a waveform appearing in the waveform display window (bottom). If a waveform still does
not appear, the pd patch is not receiving a signal.

6.2

Part 2: Amplitude

1. Pluck the string gently and consider the sound it makes. If you were to plot the amplitude of
the string sound over time, what shape would you expect the plot to have? Now, pluck the
string more forcefully.
Ensure that the waveform is not clipping. Clipping occurs if the amplitude is too large to be
recorded properly. This is evidenced by the pluck recording being cut off, clipped, or limited
at the boundaries of the waveform display (in this case -1 and 1 on the vertical axis). If
clipping is occurring, reduce the input gain (volume) slightly for the sound interface. This
can often be accomplished by turning a knob on the sound interface. Sometimes it is necessary
to adjust the volume in software with a control panel. Continue after you have ensured that
clipping is not occurring.
Does the string sound differently when plucked more forcefully? How would the shape of the
plot differ from the shape of the gentle pluck plot?
2. If pd is receiving audio signals as confirmed by Part 1, you are ready to make your first
measurement of a string pluck. Press the button marked “Click Here to Begin Recording
1”. Recording begins immediately even though the recording display does not immediately
update. Pluck the string gently and wait. After 10 seconds have elapsed, the plot marked
7

http://ccrma.stanford.edu/˜jos/lab inst/1-1.pd
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“recording1” will update with the recorded waveform. Clicking the record button again will
overwrite a previous recording.
Think about how the string looks when it is vibrating. It is vibrating so fast that you probably
cannot track it moving back and forth with your eyes, you merely see a blur. This blurring
also affects the waveform display. In 10 seconds, the string vibrates so many times that no
visual representation can trace out all of the individual cycles. As a result, the waveform
display shows only the outline of the string’s vibrations–much like how you can see the edges
of the blurring action when you watch the vibrating string with your eye.
3. Next, make a recording of a harder string pluck. Using the same procedure, click the button
marked “Click Here to Begin Recording 2” and then pluck the string firmly.
You should now have a graphical display of the two waveforms similar to the display in Figure
3. Note the difference in the two recorded waveforms. The recorded samples can be played
back by clicking the appropriate “Click Here to Play Recording” button. Do they differ in
any ways besides volume?

Figure 3: Screen-shot of pd patch 1-1, showing recorded string envelopes.
4. Note that while the string plucks decay over time, the decays are not perfectly exponential.
This is because vibrating strings are more complex than lightly-damped oscillators. However,
the beginnings of the decays should at least be approximately exponential. Consider what
the sources of friction with respect to the two plucks are. How should the initial decay rates
of the two recordings compare?
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In a moment, you will determine the time constants for your recordings. Scroll down to
the bottom of the Pd patch window. You should see two plots called log(recording1) and
log(recording2). They correspond to 10 log10 E(t) for the gentle and hard string plucks, respectively. Note that they do not make out perfect lines. However, they should be comparable
to Figure 4, where the red lines indicate the way that a line may be fit approximately to the
beginnings of the plucks. The time constants for these recordings are about 0.8sec and 1sec.

Figure 4: Log-total energies 10 log10 E(t) for a gentle pluck (above) and a harder pluck
(below).
Now calculate the time constants for your recordings. If you wish to check your method, you
may use the given time constants for Figure 4. How do your time constants compare? How
should they compare?

6.3

Part 3: Fundamental Frequency

Now that we’ve looked at what the waveform looks like on a scale of seconds, let’s turn to what
the waveform looks like on a scale of milliseconds. The waveform window shows a 200ms sample
of the waveform. Pluck the string and take a look at what the wave looks like.
8

1. The waveform window can be paused to take a snapshot by pressing the “pause” button. It
can be restarted with the “begin” button. Pluck the string and pause the waveform shortly
thereafter. An example waveform is shown in Figure 5.

Figure 5: Screen-shot showing lower portion of patch 1-1.
When a waveform repeats itself, it is known as periodic. The period of the waveform is the
shortest possible time after which the waveform always repeats itself.
Consider the following questions:
(a)
(b)
(c)
(d)

Does the waveform appear to repeat?
Is each repeated section of the waveform the same (i.e. is it periodic)?
What does the waveform look like?
Does it look like a pure sine wave or something different?

You should be able to see that the waveform does, indeed, repeat with a constant frequency.
This frequency determines the pitch of the sound the string makes. However, the repetition
is not exact for real strings because the pluck decays gradually.
2. After you are able to capture a good sample of the waveform in the waveform window, see
if you can measure the period and calculate the fundamental frequency. Try to figure out
how long it takes for the signal to repeat. The time scale is indicated on the bottom of
the waveform window, and each notch corresponds to 10 ms. A reasonable period might be
something around 60 ms. For comparison, the period of the waveform in Figure 5 is about
62ms although the waveform repeats itself every 62ms, 124ms, 186ms, 248ms, ...
3. Calculate the fundamental frequency with the following relationship:
frequency =

1
,
period

(7)

where the period is in seconds and frequency is in Hz (cycles per second). Thus, for example,
if the period were 62 ms, the calculation would be as follows:
frequency =
9

1
= 161Hz
0.0062

(8)

Now figure out which note on the piano your computed fundamental frequency is closest to.
To compute the fundamental frequency in Hz corresponding to a given piano note number d
(where d = 69 corresponds to piano note A4 (the A above middle C on the piano)), you can
use the following formula:
f0 = 440 · 2(d−69)/12 ,
(9)
where f0 is the frequency in Hz. Solve this formula for d in order to compute a note number
from a given fundamental frequency.
For reference, a table of fundamental frequencies and corresponding notes can be found at
http://www.liutaiomottola.com/formulae/freqtab.htm.

6.4

Part 4: Frequency Content

Looking back at the waveform from Part 2, you may have wondered why the signal is not a pure
sine wave (like an ideal tuning fork would produce). The waveform display seems to indicate that
there are additional oscillations in the signal which cause secondary peaks and other shapes to
appear. In this part of the lab, we will consider the frequency spectrum of the signal and how
it affects the way the string sounds. In short, the fundamental frequency calculated in Part 2 is
not the only frequency present in the signal, but there is energy at other frequencies as well. The
amplitude versus frequency is an important function called the spectrum, which affects the timbre
of the sound. For example, a “brighter” tone corresponds to more energy in the high-frequency
overtones.
1. Close patch 1-1, and do not worry about needing to save any information stored in the patch.
Download lab patch 1-2 (1-2.pd)8 and save it to a local directory. Then open 1-2.pd with
pd.
2. Also, double check that pd is not in edit mode by clicking the Edit menu and making sure
that “edit mode” is not checked.
3. Pluck the string. The frequency window shows a plot which indicates the spectral content of
the signal as the signal is read into the sound card.
Peaks in the plot indicate energy in the signal at that particular frequency. For example, in the
plot below, peaks occur at around 165 Hz, 330 Hz, 495Hz, . . . . An example is shown in Figure
6. The peaks are called partial overtones. They are nearly harmonically related, as long as
the string is not stiff, so they are also called harmonic overtones, or simply harmonics. If they
were exactly harmonically-related, then the nth harmonic would be given by the following
for n = 1, 2, 3, ...:
f (n) = nf0
(10)
4. Pluck the string once firmly and once softly. Look at the peak corresponding to the fundamental frequency calculated in Part 2. How does the amplitude of this harmonic change over
time? Is the amplitude of the fundamental frequency greater in the firm or soft pluck? Can
you see any change in the harmonic peak locations between just after the pluck and late in
the decay?
8

http://ccrma.stanford.edu/˜jos/lab inst/1-2.pd
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Figure 6: Pd plot showing harmonics in the magnitude spectrum of the recorded string
vibration in response to a pluck.
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5. Pluck the string again and now consider the amplitude of the next peak in the plot with a
frequency higher than the fundamental frequency. This peak is called the second harmonic,
and it occurs at twice the frequency of the fundamental frequency.
(a) Carefully measure the frequency of the fundamental frequency and the second harmonic.
Is the ratio exactly 2.000? If not, what do you measure for this ratio? How can this be
explained?
(b) Pluck the string softly and more firmly, and consider the strength of the second harmonic
relative to the fundamental frequency. Is there a difference?
6. Acquire a guitar slide or something similar (a smooth glass bottle will work) and press it
against the end of the string roughly 3 inches from the bridge. Pluck the string. Now slide
the object closer to the bridge, essentially changing the effective length of the string. How
does the sound of the string change? Can you see a change in the spectrum?
7. Each of the harmonics is due to a standing wave on the string. Note that for the even
harmonic standing waves, the string does not move at all at its midpoint. However, for the
odd harmonic standing waves, the string always moves at its midpoint. Consider what would
happen to the pitch if it were possible to mute only the odd harmonics while allowing the
even harmonics to ring?
Pluck the string once and quickly mute the string at its midpoint for a moment so that the
string continues to ring but with a different pitch. Since the underside of your index finger is
soft, one way to mute the string is to gently but steadily press the underside of your finger
against the midpoint of the string. It may take several tries to find the exact midpoint. It
will however be obvious once you achieve it.
This muting action should allow you to mute the fundamental frequency. How does the pitch
change? How would you expect this change in pitch to be reflected in the spectrum? Does
the frequency plot indicate what you would expect?
This technique is often used by guitarists in order to create a unique and higher pitched
sound. An example plot of the spectrum with the fundamental frequency muted is shown in
Figure 7.

Challenge Problem
Pluck the monochord at its midpoint and see if you can observe two traveling corners propagating
away from the plucking point. It should evolve from an initial triangular shape, through a succession
of trapezoidal shapes, until an inverted triangular shape is assumed, followed by a succession of
inverted trapezoidal shapes until the original triangular shape is achieved. This behavior can be
deduced from measurements made at various points along the string at known times relative to the
initial pluck time.
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Figure 7: Plot of the spectrum of the second harmonic of string vibration in response to
a pluck.
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